
Power Photo
Power Photo Software

This Power Photo Software can let you review the photos stored on a Photo CD Disc, edit and 
save the photos by using Windows
Clipboard or by exporting them to files in standard file formats,
such as TIFF (Tagged Image File Format) and EPS (Encapsulated PostScript).

How      to ....
1. Look at all the photos on a Photot CD disc.
2. See an enlargement of photos in photo window.
3. Load photos directly from the Photo CD disc.
4. Crop a photo in the photo window.
5. Edit Photo.
6. Saving edit.
7. End a session

What      insides ...
1. File Menu.
2. Edit Menu.
3. Color Menu.
4. Rotation Menu.
5. Sizing Menu.
6. Window Menu.

What      is ...
1. Overview Windows.
2. Photos Windows.
3. Current Thumbnail.



Look at all photos
1. Choose File/Open Overview, and confirm your CD-ROM drive designation.

2. Click OK to load the disc.    A overview window is dislayed on the screen, which shows versions 
of all the photos on your    Photo CD disc.

3. Choose File/Get Info for getting information about the Photo CD disc and the individual photos.   
The information is provided by the photofinisher.

See also
Direct load photo
Current Thumbnail



Direct load photo
To load photo directly from the Photo CD disc into a photo window without opening a overview    
window:

1. Specify the drive you want to load.
2. Click a photo filename from filename listbox.
3. Click OK button to load.
4. You can also double-click a photo filename to load.
5. When you select a photo, you can enable the preview check box to see a overview of a photo 
before you load it.



Current Thumbnail
      A thumbnail with red rectangle arround means the current thumbnail.    With current thumbnail, 
you can:
n 1. Nevigate all the thumbnails in the overview window with arrow key.
n 2.    Press enter key or double click to view the enlargement of current thumbnail.
n 3. Press space bar to toggle the current thumbnail for later export.
n 4. Press CTRL+SPACE to toggle multiple thumbnail.
n 5. View the thumbnail information from menu File / Get information



See enlargement of photos
1. Double click the photo on the overview window, and a image window opens.
2. Or, choose File/Open Photo, A photo window opens.



Cropping a photo
1. Load a photo.
2. Move the mouse to the upper left corner of crop region on the photo window, hold the left mouse
button down.
3. drag the dash rectangle to the desired location for cropping a photo.
4. Release left mouse button, a cropping region of photo is done.
5. To undo your most recent crop action, choose Edit/Undo Crop.    You can undo all cropping on a 
given photo.



Edit photos
For editing photos, Power Photo Software provides serials of    functions to working on.
n 1. Colors Menu: changes the color range (palette) used    to display or export the currently 

selected photos.
n 2. Sizing Menu: changes the resoluation, or size in pixels, to display or export the current 

selection.
n 3. Rotation Menu: rotates the current selection 90 degrees clockwise or counterclockwise, 

produces its mirror image, or flips it upside-down.
For cropping tool, please refer to    Crop photos in the photo window.
Note: The changes you make with menus override the defaults established in File/Preferences and
determine the format used to display the currently selected photos.    These settings also determine
the format in which the currently selected photos are written to the Clipboard if you choose 
Edit/Copy or export the photos to a files if you choose File Export.
        The cropping changes that you make determine the format.    None of these changes alters 
your Photo CD disc in any way; they only apply to copies of the photos in memory.



Save editing
Copy the photo to the Clipboard by choosing Edit Copy and then paste it into another application.    
Power Photo Software can paste the photo as a device-independent bitmap, a bitmap.    
Note: Some programs may not be able to accept any of these formats.



End a session
Choose File Exit to exit.      Don't forget to save your edits to the Clipboard before you exit.



File Menu

Content of the File Menu
You can use the File menu to:
1. Open Overview : open Overview and photo windows.
2. Load Photo : load photo from the Photo CD disc.
3. Export : export photos to a standard file type.
4. Get Info : display creation-time information about the current Photo CD disc.
5. Preferences : specify default settings for displaying and exporting photos.
6. Exit.



Open Overview Window
Reads into memory the photos on the Photo CD disc in the drive that you specify and displays the 
photos in a overview window using the colors (palette) and image size in pixels (resolution) 
specified with File/Preferences.
Specify the drive that contains the Photo CD disc you want to load.
To continue with the load, click OK. An indicator in a dialog box shows you what percentage of the 
load has completed as the operation progresses.

When the load finishes, a overview window shows all the photos on the Photo CD disc.



Load Photo
Reads one or more photos from a Photo CD disc into memory and displays each in a photo 
window using the default colors (palette) and default image size in pixels (resolution) specified with
the File/Preferences menu command.
First, specify the drive that contains the Photo CD disc you want to load. A list box displays the 
names of the photos stored on that Photo CD disc.
Select a single photo by clicking. If you select the Preview check box, you can see a miniature 
version of one selected photo in the preview box.
To continue with the load, click OK. An indicator in
a dialog box shows you what percentage of the load
has completed as the operation progresses.

Load Selected Photo
Displays the photo(s) that you have selected from the active Overview Window in a Photo Window 
(in individual photo windows) in the default colors and default size that you have specified with 
File/Preferences or the Colors and Size menus.



Export
Saves the currently selected photo(s) in the file(s) of the format you specify. Power Photo Software
exports photo(s) using the current settings for color range (palette), size (resolution), and rotation 
for the selected photo(s). You can change the settings
for color range and image size in the select format dialog box. File/Export is unavailable when 
there is no photo selected or no photo displayed.
When you choose this command, the Export Path dialog box displays on the screen, you have to 
specifiy the output path. Then the Select Format dialog box is displayed, notifing you to select the 
Format,Size, and Colors in which you want the photo(s) to be stored. The following graphic file 
formats are available for export:
Extension Format

BMP Windows device-independent bitmap
EPS Encapsulated PostScript
PCX                                            PC Paintbrush
RIF                                              Resource Interchange File Format
TIF                                                Tagged Image File Format
WMF Windows Metafile Format
When exporting multiple photos, each photo is named with a sequence number corresponding to 
the photo number and using the extension that corresponds to the export format.



Get Information
Displays creation-time information about the currently selected photo. This information is stamped 
on the Photo CD disc by the photofinisher.
The Disc Information group box includes:
n Serial Number for the disc.
n Creation Time shows the first time the Photo CD disc was written.
n Last Modification shows the most recent addition to the Photo CD disc.
n Number of images currently stored on the Photo CD disc.
n Number of sessions shows the number of times the Photo CD disc has been written on by the 

photofinisher.
The Photo Information group box includes:
n Scan Time when the photo was written onto the Photo CD disc.
n Media Id shows the source of the image.
n Media Type shows the film type.
n Photofinisher shows the name of the firm that processed the image from film.
File/Get Info is unavailable until you load a Photo CD disc.



Preferences
The Preferences command in the File menu allows you to alter some default settings for overview 
windows, photo defaults.

You can change the default size and palette for both overview and photo windows. These defaults 
control how photos are displayed, as well as how they are exported.

Overview Window specifications include:
n Size: Specifies the format to display photos in overview windows. This setting affects only the 

overview appearance. The larger the format you select, the larger the photos display in the 
overview window.

n Palette: Sets the default palette. This setting affects only the overview window appearance. 
You can change to a smaller palette for a different visual effect and to save time loading 
images. Initially, the default palette is maximum number
of colors your monitor can display.

n Changes to overview window specifications take effect only when the next overview window is 
loaded.

The Photo Defaults affect how photos are displayed in photo windows and how they are exported. 
The initial defaults provide a good-quality display and relatively fast response. You can
specify:
n Size: To speed up the display in photo windows, choose a smaller default photo format. To 

improve the display quality, choose a larger default photo format.
n Palette: To save time loading images, choose a smaller default palette. The palette is initially 

set to the maximum number of colors your monitor can display.
n Changes made to the photo defaults take effect the next time you load a photo and do not 

affect currently loaded photo windows.



Exit
Ends the current session.    Don't forget to copy your edit to the
Clipboard or export it to a file before you exit.



Edit Menu

You can use Edit menu:
1.Undo Crop: undo the most recent crop action.
2.Copy: copy a photo to the Clipboard.
3.Select All: select all the photos on the current overview window.



Undo Crop
Cancel the recent crop action on the current photo.
Edit Undo Crop is unavailable until you crop a photo.



Copy
Puts a copy of the selected photo on the Clipboard using the colors (palette) and image size in 
pixels (resolution) that you have specified with File/Preferences or with the Colors and Size menus.
If the photo is cropped, it is copied that way. When
you copy a photo, the new photo replaces anything previously copied to the Clipboard.
When you copy a photo, Power Photo Software stores the instructions for creating a copy of the 
photo in one of the following formats:

device-independent bitmap (DIB), 
bitmap, 
picture (metafile). 

Note: Some programs cannot accept images in these formats.
The copy operation actually occurs when you paste the photo into another application. Edit/Copy is
fast, but there may be a short wait when you paste the photo. If you exit without pasting the copied 
photo, it is copied to the Clipboard before you exit. This may also cause a slight delay.
Edit/Copy is unavailable when you have either not selected a photo or have selected more than 
one photo.



Select All
Selects every photo in the active overview window for later export.
Once you select all, the menu item will automatically become Unselect All, which unable you to 
select all photos.



Colors Menu

Use the Colors menu to specify the palette (number of colors or shades of gray); to display the 
currently selected photo(s) in the photo window(s); or to export the photo(s), overriding the default 
setting specified with File/Preferences. The Colors menu is unavailable when you haven't load a 
photo.
If your monitor is not capable of displaying the color range you selected, the graphics card must 
convert from the selected color range to the maximum range your monitor can display. This may 
result in slow display of the image.
When you change a photo's color range, only the colors of the pixels for the copy in memory are 
affected. The larger the number of colors you choose, the more memory the photo requires. It
saves time an memory to choose a color range that is less than or equal to the color range your 
monitor is capable of displaying. You can specify a larger color range prior to copying to the 
Clipboard or exporting the image.
1. True Color.
2. 256 Colors.
3. 16 Colors.
4. 256 shades gray.
5. 16 gray.



True Colors
Sets the color range to millions of colors (full 24-bit color) at which the selected photo(s) will be 
displayed, copied to the Clipboard, or exported to a file, overriding the default established by 
File/Preferences. This gives you millions of shades of colors. Full 24-bit color is RGB color. When 
you export a photo using millions of colors, all the color information stored on the Photo CD disc is 
preserved in the exported copy.
if your monitor is not capable of displaying 24-bit color (a VGA monitor cannot display millions of 
colors), your graphics card must convert from 24-bit color to the maximum palette you have. This 
may result in slow display of the image.

When you change a photo's color range, Power Photo Software changes the color of the pixels for 
the copy in memory. To change the palette, you must have the Photo CD disc in the CD-ROM 
drive. The larger the number of colors you choose, the
more memory the photo requires.



256 Colors
Sets the color range to a balanced range of 256 colors at which the selected photo or photos will 
be displayed, copied to the Clipboard, or exported to a file, overriding the default established by 
File/Preferences.

When you change the palette of a photo, Power Photo Software changes the colors of the pixels 
for the copy in memory. To change the palette, you must have the Photo CD disc in the CD-ROM 
drive. Also, the larger the palette you choose, the more memory the photo requires.



16 Colors
Sets the color range to a balanced range of 16 colors at which the selected photo or photos will be 
displayed, copied to the Clipboard, or exported to a file, overriding the default established by 
File/Preferences.

When you change the palette of a photo, Power Photo Software changes the colors of the pixels 
for the copy in memory. To change the palette, you must have the Photo CD disc in the CD-ROM 
drive. Also, the larger the palette you choose, the more memory the photo requires.



256 shades of gray
Sets the color range to 256 evenly stepped shades of gray at which the selected photo or photos 
will be displayed, copied to the Clipboard, or exported to a file, overriding the default established by
File/Preferences.

When you change the palette of a photo, Power Photo Software changes the colors of the pixels 
for the copy in memory. To change the palette, you must have the Photo CD disc in the CD-ROM 
drive. Also, the larger the palette you choose, the more memory the photo requires.



16 shades of gray
Paragraph Sets the color range to 16 evenly stepped shades of gray at which the selected photo or
photos will be displayed, copied to the Clipboard, or exported to a file, overriding the default 
established by File/Preferences.

When you change the palette of a photo, Power Photo Software changes the colors of the pixels 
for the copy in memory. To change the palette, you must have the Photo CD disc in the CD-ROM 
drive. Also, the larger the palette you choose, the more memory the photo requires.



Rotation Menu

You can use Rotation Menu,
n 1. Rotate photo 90 degrees clockwise.
n 2. Rotate photo 180 degrees clockwise.
n 3. Rotate photo 270 degrees clockwise. ( 90 degrees Counterclokwise).
n 4. Make a mirror image of photos. (Reverses each selected photo along its vertical axis from 

side to side to produce the photo's mirror image)

To restore the original orientation, choose Normal.



Sizing Menu

Use the Size menu to specify the resolution in pixels to display the currently selected photo(s) in 
the photo window(s) or to export the selected photo(s), overriding the default setting that you 
specified with File/Preferences. The Size menu is
unavailable when you haven't selected a photo or photos. The various sizes are intended for 
different purposes:
n 128 x 192 (Wallet) : for selecting and previewing.
n 256 x 384 (Snapshot) :for low-resolution image manipulation.
n 512 x 768 (Standard) : for moderate resolution (TV comparable).
n 1024 x 1536 (Large) :for high-resolution image handling (HDTV).
n 2048 x 3072 (Poster) :for photographic-quality printing and enlargement
When you choose a larger size, the photo is displayed using more pixels (and more memory) as if 
you had just obtained a larger negative from which to print a picture. Use the scroll bars to see 
areas of the photo that do not appear in the photo window.



Window Menu

Use the Window menu to tailor the layout of windows and icons on the desktop, to see a list of the 
Power Photo Software windows, and to make a currently inactive open window active.
1. Cascade
2. Tile
3. Arrange Icons
To make one of the windows on the list active, click on the window name.



Overview Window

The overview window lets you look at many photos at one time in a small display format. When you
choose File/Load overview, Power Photo Software creates a window that contains a small copy of 
every photo on your Photo CD disc. If all the photos do not fit on one screen, you can use the scroll
bars to see the rest of the contact sheet.

You can control the colors (palette), the resolution (size in pixels),when it displays a new Overview 
window. Choose File Preferences to do this.

You use the Overview window to see all the photos on a Photo CD disc as a set, and select one or 
more photos with which you want to work.

Once you have selected a photo or group of photos, you can customize the color range, the 
resolution, and the orientation used to display or export the selection. It is more efficient to make 
changes in the Overview window before you display the selection in a photo window or set of photo
windows.



Photo Window

The photo window displays a single photo using the color range (palette) and resolution (size in 
pixels) currently specified for the selected photo or photos.

You can open a photo window in several ways:
n Double click a photo in the overview window
n Choose File Load Photo and follow the prompts
You can control the color range, resolution, and orientation used to display the currently selected 
photo in a photo window (or the currently selected photos in individual photo windows) with the 
Colors, Size, and Orientation menus. Changes that you make through these menus apply only to 
the currently selected photos, locally overriding the default settings established by File 
Preferences.

Power Photo Software displays the photo in the photo window at the size you specified. The actual
size of the photo window depends on the size of your screen pixels. If the photo is bigger than your
screen, you can use the scroll bars to see the
rest of the photo.






